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CREATING YOUR OWN SIZE OF WINDOW IN 
PLANSXPRESS™ AND ESTIMATORXPRESS® 

 
 

15-20 
Minutes 

 
This topic is for users of PlansXpress™ Total Toolkit Edition and EstimatorXpress®. To upgrade to 
PlansXpress™ Total Toolkit or purchase EstimatorXpress®, call the HBXL Sales Team on 0870 850 2444. 
 
To create a new window in PlansXpress™, it helps 
to understand how PlansXpress™ draws windows, 
and how the windows you draw are estimated in 
EstimatorXpress®. PlansXpress™ uses the window 
width entered in the Dimensions Wizard to draw 
each window in plan. Each window is linked to an 
elevation drawing (known as a symbol) which 
appears in any elevations you create containing the 
window. Each window is linked to a symbol of a 
defined size. For example, the 1800 x 1200 window 
is linked to an 1800 x 1200 window symbol. Each 
window also links into an EstimatorXpress® 
Window Worksheet which contains a specific size of window, window frame and lintel etc. Therefore, if 
you want a different size of window, you can’t just change the window opening dimensions, as the 
window won’t appear the desired size in elevations and will not be estimated correctly. Therefore, you’ll 
notice that the window dimensions are greyed out in the Dimensions Wizards. 

 
Note: You can enter window dimensions into the Dimensions Wizard of a Custom Size Window. 
However, this is not the recommended method as a window based on a Custom Size Window will only 
appear in elevation views as an outline and you will have to draw the detail of the window for yourself. 
Also, every time you import a custom window into EstimatorXpress® you will have to specify the 
window, window frame, lintel and all associated labour etc. Therefore, it is advisable to use a window 
template with a specified size where possible or create your own Window template in PlansXpress™ and 
EstimatorXpress®.  
 
This topic talks you through creating a different size of window for use in PlansXpress™. First, we will 
create a window symbol in PlansXpress™ by editing an existing one. Next, we will create a window 
Worksheet in EstimatorXpress® to estimate the window. Finally, we will link the Worksheet to the 
window symbol. Creating a Window therefore requires the use of both PlansXpress™ and 
EstimatorXpress®. 
 
Imagine the window you want to use is an irregular 1805 wide by 1200 deep made by the manufacturer 
Windowstra, and you want to create a template for a window of these dimensions. Let’s start by editing 
an existing window symbol to create a window which is 1805 wide. 

 

 
1. Double click on the PlansXpress™ icon or go to Start,  All Programs, HBXL, PlansXpress and 

click on the PlansXpress™ icon to launch the software. 
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The New Drawing dialog box pops up. We’re going 
to open an existing drawing (a window symbol) so 
we don’t need to select a template. 
 
2. Click Cancel. 

 
3. Go to the File menu and click Open. 

  
The Open dialog box pops up. You need to 
locate a window symbol in the Symbols folder 
in PlansXpress™. 
 
The file locations given below are correct for 
PlansXpress™ Version 1.02 and later. If you 
are running an earlier version of 
PlansXpress™, go to www.hbxl.co.uk and 
download an update for the latest version 
before continuing. 
 
4. If you’re running Windows® 2000 or XP, 

locate the folder C:\Documents and 
Settings\All Users\Application 
Data\HBXL\PlansXpress\Symbols\Window
s\Standard Windows\1200 Deep Standard 
Windows. 

 
If you’re running Windows® Vista, locate 
the folder 
C:\ProgramData\HBXL\PlansXpress\Symb
ols\Windows\Standard Windows\1200 
Deep Standard Windows. 
 

5. In the 1200 Deep Standard Windows 
folder, find and click on the symbol called 
312C 1800 x 1200 Standard Window Side 
Hung.pxd. 

 
6. Click Open. 

 
 
 Troubleshooting 

 
If, when you navigate through the folders, you 
cannot see the Application Data folder in Windows® 
2000 or XP, or the ProgramData folder in Windows® 
Vista: 
 
• your computer is set to not show hidden files 

and folders. To switch your computer to show 
hidden files and folders, go to the Start Menu, 
click Control Panel and select Folder Options. 
The Folder Options dialog box pops up. Click on 
the View tab and in the Advanced Settings list, 
click the Show hidden files and folders option. 
Click OK. The Application Data or ProgramData 
folder should now be visible. 
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The window symbol is opened as a pxd file. The symbol is ‘exploded’ into all its component lines and can 
be edited. First we’ll save the symbol with a new name to ensure we don’t accidentally overwrite the 
original symbol. 

 
7. Go to the File menu and click Save As. 
 
The Save As dialog box pops up. 
 
8. Enter a suitable name for the window, 

such as 312C Windowstra 1805 x 1200 
Standard Window Side Hung. 

 
9. Click Save. 

 
Let’s now edit the symbol. To make the window the correct size, we’re going to stretch the right pane of 
the window using the Stretch tool. 
 

10.  Press the Stretch button on the Modify Toolbar. 
 
We need to select the right hand side of the window in order to stretch it. 
 
The instruction bar reads: Give first corner of 
box to Stretch. 
 
11. Hold your mouse above and towards the 

right hand side of the window. 
 

12. Click the left mouse button to 
register the first corner of the box to 
stretch. 
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The instruction bar reads: Give second corner 
of box to Stretch. 
 
13. Move your mouse down and to the right 

of the window. 
 
You’ll see a rectangle appears, outlining the 
area which will be moved when the stretch is 
carried out. 
 

14. Click the left mouse button to 
register the second corner of the box to 
stretch. 

 
We’ve now defined the area we want to stretch. 
 
The instruction bar reads: Give Reference 
Point. 
 
15. Hold your mouse over the top right 

corner of the window until appears 

with the message ‘Int’ or  appears with 
the message ‘End’. 

 

16. Click the left mouse button to 
register the Reference Point. 

 
The instruction bar reads: Give Point To Stretch To. 
 

17. Press the right arrow key on your keyboard. 
 
The Distance dialog box pops up. 
 
18. Enter 5 into the input box. 
 
19. Click OK. 
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The area of window selected is moved 5mm 
to the right and the window is stretched to be 
5mm wider overall. 
 
All we need to do now is set the insertion 
origin for the window. The insertion origin is 
the point on the symbol which is placed when 
you click your left mouse button to insert the 
symbol. The insertion origin for windows is 
usually the midpoint along the bottom of the 
window. 

 
We will place a construction line showing the midpoint along the bottom of the window to help us place 
the insertion origin. 
 

20.  Press the Vertical Construction Line button. 
 

21.  Ensure the Nearest Snap button is switched on. 
 
22. Hold your mouse over the left side of the 

Window until  appears along with the 
message ‘Near’. 

 

23. Press the R key on your keyboard. 
 

24. Press the right arrow key. 
 
The Distance dialog box pops up. 
 
25. Enter 902.5 (half the width of the 

window) into the input box. 
 
26. Click OK. 

 



PlansXpress™ Tutorials  

 6

The construction line appears running down 
the middle of the window. We can now set 
the insertion origin for the window. 

 
27. Go to the Modify Menu and click Set 

Insertion Origin. 

 
The instruction bar reads: Give Insertion 
Origin Point. 
 
28. Hold your mouse over where the vertical 

construction line intersects the bottom of 

the window until  appears along with 
the message ‘Int’. 

 
29. Click the left mouse button to register the 

position of the insertion origin. 

 

30.  Press the Delete Construction Lines button on the Draw Toolbar to remove the construction 
line. 

 
A dialog box pops up asking if you wish to delete the construction lines. 
 
31. Click Yes. 
 

32.  Press the Save button to save the changes to the window. 
 
 
You’ve now created the window symbol and are ready to create a Worksheet in EstimatorXpress® to link 
to the symbol. 
 
If you add your own Window Worksheets into existing EstimatorXpress® Window Workbooks, these 
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new Worksheets will appear, available for use, in the Windows Menu in PlansXpress™. However, if you 
copy a Window Workbook, it will not automatically link up with PlansXpress™. Because the window you 
are creating fits suitably within an existing Window Workbook, PVCu Windows 1200 Deep, you should 
add the Worksheet within this Workbook. If you wanted to create a new style or depth of window, you 
should create a new Worksheet in the generic Window Workbook. If you want a Worksheet to link with 
PlansXpress™, it must be created within a Workbook in My Workbooks, which is accessed from the My 
Settings Menu. Do not create the Worksheet within an estimate.  
 

 

33. Double click on the EstimatorXpress® 7 icon or go to Start,  All Programs, HBXL, 
EstimatorXpress7 and click EstimatorXpress® 7 to launch the software. 

 
34. From the Main Menu, click on My 

Settings. 

 
35. Click My Workbooks. 
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36. Scroll down the Library of Workbooks and 
locate the Workbook called PVCu 
Windows 1200 Deep which can be found 
in the Windows Workbook Type towards 
the bottom of the screen. 

 
37. Click on the PVCu Windows 1200 Deep 

Workbook. 
 

38.  Press the Open Workbook 
button. 

 
A dialog box pops up asking you to select a 
Specification upon which to base the 
Workbook. The choice of Specification is not 
important as you are going to change Sundry 
products (i.e. resources which are not linked 
to the Specification) within the Workbook. 
 
39. Click on any of the Specifications. 
 
40. Click Select. 

 

 
41. Click on the Worksheet called 312 C 1800 

x 1200 window. 
 

42.  Press the Copy Worksheet 
button. 

 
The New Worksheet dialog box pops up. 
 
43. Enter an appropriate Name for the 

Worksheet, such as Windowstra 
1805x1200 window, and a Location, such 
as House. 

 
44. Click OK. 

 
The Worksheet opens up in the dimensions section. 
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45. Overtype the width of the window with 

1.805 (remember we’re back in 
EstimatorXpress® so we’re working in 
metres). 

 
46. Review the remaining window dimensions. 
 

47.  Press the View Resources Output button. 
 
48. Scroll down the screen to the Sundry 

Items. 

 
The window currently specified is the wrong size, so we need to swap it for a correct size window. 
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49. Click on the Resource specified for the 
Window. 

 

50.  Press the Change Resource 
button. 

 
The Price Book opens with the current 
specified item highlighted. The window we 
want to use for this Job doesn’t yet exist in 
the Price Book so we need to add it. 
 
51. Press the New Resource button. 

 
The New Resource dialog box pops up with 
the details of the original window. 
 
52. Edit the Description of the Resource to 

something more appropriate such as 
Windowstra PVC Window Clear Low E 
Glass 1805 x 1200mm. 

 
53. Change the Unit Cost of the Window to 

£400. 
 
54. Change the Supplier to Provisional. 
 
55. Review the remaining details, and when 

you’re happy, click OK. 
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You are returned to the Price Book where the 
window you’ve created has been added, and 
is highlighted. 
 
56. Press the Select Resource button to 

select the window for use in the 
Worksheet. 

 
You are returned to the Resources Section of the Worksheet where the Edit Resource dialog box is 
open. 
 
57. Check the Usage Factor and 

Build Phase are correct. 
 
58. Click OK. 

 
The window you‘ve added is now specified in the Worksheet. The specified window appears in bold to 
demonstrate that it has been modified from the original window. You can remove this Modified Marker. 
 
59. Click on the Markers button and click 

Clear Modified Marker. 

 
Care should be taken to check the materials and labour in the Sundry Items are appropriate when you 
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create a new window Worksheet . In this case, the lintel already specified should be fine, as the new 
window is only 5mm wider. 
 
60. Check the remaining Sundry Items are suitable. 
 

61.  Once you’re happy with the Resources, press the Back button to return to the dimensions 
section of the Worksheet. 

 

62.  Click Close to close out of the Worksheet. 
 

63.  Click Close to close the Workbook. 
 
A dialog box pops up asking if you wish 
to overwrite this Master Workbook. 
 
64. Click Yes. 

 
The Select Elevation Image dialog box pops 
up, asking you to select an image to associate 
with the Windowstra 1805x1200 window 
Worksheet. 
 
65. Scroll down the list and double click on 

Windows in the left hand menu. 
 
You’ll notice that the options you click 
through reflect the file structure in the 
Symbols folder. 
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66. Double click on the Standard Windows 
option. 

  
67. Double click on the 1200 Deep Standard 

Windows option.  

 
68. Locate the image you created, called 

312C Windowstra 1805 x 1200 Standard 
Window Side Hung, and click on it.  

 
69. Click OK. 

 
You are returned to My Workbooks. You’ve finished creating the Worksheet and have linked it up to the 
window symbol you created. 
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70. If PlansXpress™ is still open, you can 
refresh your Architectural Toolbar Menus 
to show the window Worksheet you’ve 
created by going to the Architectural 
Menu and clicking Refresh Menu. If 
PlansXpress™  is closed, the Window will 
automatically appear in the Windows 
Menu when you launch the software. 

 
 
71. You can now insert the window into your PlansXpress™ drawing in the normal way. 
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